
See the About Sibelius dialog for a full list of the software development team and other credits.

We would like to thank all those (too numerous to list) who have provided helpful comments and suggestions for Sibelius and its documentation.

Legal Notices
This product is subject to the terms and conditions of a software license agreement.

This guide is copyrighted © 2011 by Avid Technology Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.

Avid, Sibelius and Scorch are registered trademarks of Avid Technology, Inc. in the USA, UK and other countries. All other trademarks are acknowledged as the property of their respective owners.

Product features, specifications, system requirements, and availability are subject to change without notice.

Document Feedback
We are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, please email us at docs@sibelius.com.
Contents

Introduction to network site licences ......................................................... 4

Installing and upgrading ................................................................. 5
  Installation on Windows ................................................................. 7
  Installation on Mac OS X ............................................................... 10
  Upgrading on Windows ................................................................. 13
  Upgrading on Mac OS X ............................................................... 15
  Installing Sibelius ........................................................................... 17

Configuring and using the Licence Server ........................................... 19
  Configuring the Licence Server ....................................................... 21
  Registering the Licence Server ....................................................... 23
  Testing the Licence Server ............................................................. 28
  Access Control ............................................................................ 30
  Setting up Classroom Control ......................................................... 32
  Checking out licences .................................................................... 33
  Working with clients ..................................................................... 36
  Reading logs ................................................................................ 38
  Maintaining the Licence Server ..................................................... 40
  Troubleshooting ........................................................................... 42

Appendices ......................................................................................... 45
  Appendix A: Starting or stopping the Licence Server ....................... 47
  Appendix B: Manually locating Licence Server logs ....................... 49
  Appendix C: Licence Server error codes ........................................ 50
  Appendix D: Useful command line commands ............................... 51
Introduction to network site licences

Two types of Sibelius site licence are available: stand-alone site licences and network site licences. You have purchased a network site licence for a fixed number of copies.

Sibelius's network version operates on a client-server model. The client is the Sibelius program itself, which is installed on the local hard drive of each of the student workstations, and the server is the separate Licence Server program, which is installed on a single designated server.

The Licence Server enables the designated number of licenced client copies to run on the network simultaneously. These are known as floating licences, because they are not tied to any particular computer on the network: any computer with the software installed can connect to the Licence Server, assuming the Licence Server has seats available. It also lets you send messages to users of the client copies, and close copies down from the server machine.

With supported products, it even allows you to specify that students can temporarily move licences from the Licence Server to their own machines so that they can run the software when not connected to the Licence Server. These are known as check out licences, because the student checks out the licence from the Licence Server, which reduces the number of floating licences available by one until the student either checks it back in, or it expires, at which point the licence is automatically returned to the pool of floating licences so that it can be used on a different computer.

The Licence Server itself does not have a graphical user interface, because it runs in the background, listening to requests from client copies of Sibelius on the network. The server is therefore configured and managed using the graphical Licence Server Control Panel, which you can run either on the computer on which the Licence Server is installed, or from another workstation.

The Licence Server and Licence Server Control Panel programs are supplied on the main Sibelius DVD-ROM, but must be installed separately from Sibelius itself.

Requirements

The Sibelius Licence Server and the Licence Server Control Panel will run on the following operating systems:

- Mac OS X: Mac OS X 10.6.8, Mac OS X 10.6.8 Server, Mac OS X 10.7.

The software has been tested both on Apple Mac workstations and on Apple Xserve servers.

Sibelius requires a network using the TCP/IP protocol. (Your network may use other protocols in addition to TCP/IP, but TCP/IP must be present in order for the Licence Server to communicate with the client copies.) If you use a firewall on your network, ensure that port 7312 is open both for TCP/IP and UDP traffic.

If you use a Novell network, note that you cannot install the Sibelius Licence Server onto a server running Novell Netware. The Licence Server can only be run on Windows or Mac OS X servers or workstations. To run Sibelius on a Novell network, you will need to install the Licence Server program on a suitable Windows or Mac OS X workstation.
Installing and upgrading
Installation on Windows

If you are upgrading your Licence Server from any earlier version of Sibelius, see Upgrading on Windows on page 13.

Installing the Licence Server

- Insert your Sibelius 7 Program Disc DVD-ROM.
- When the on-screen menu appears, click Browse this disc.
- In the Windows Explorer window that opens, double-click the Network Licence Users Only folder, then double-click LicenceServerInstaller.msi to start the installation.
- You will see the following window:

![Licence Server Installer Window]

- Click Next.
- Next you will be asked if you want to install the Windows service:

![Windows Service Installation]

Unless you are intending to install the Control Panel only on this computer (because you have already installed the Licence Server itself on another machine), you should leave the Install Windows service for Licence Server option switched on, then click Next.
Now you will be prompted to choose an installation folder:

![Select Installation Folder](image)

By default, the Licence Server will be installed to the folder **C:\Program Files\Avid\Sibelius 7 Licence Server** (on a 64-bit system, this will be in **C:\Program Files (x86)**) but you can change this if you wish by clicking **Browse**. Make sure that the Administrator group of users has full read and write access to the folder you have chosen. If your chosen folder does not exist, the installer will create it for you.

Once you have determined where the Licence Server should be installed, click **Next**.

- You are told that the installer is ready: Click **Next**.

- You will see a progress bar as the Licence Server and Control Panel are installed. If you have a firewall active, you may see a window appear telling you that **LicenceServerV6.exe** is trying to access the Internet: this is normal and happens when the Windows service is started for the first time. Choose whichever option tells your firewall that this program is safe to access the Internet. Depending on the specific firewall you are using, you may not receive a notification at this point, in which case you should now go to your firewall’s control panel and open port 7312 for both TCP and UDP traffic.

- After a few moments, you will be told that installation has completed successfully. Click **Close** to exit the installer.

**Configuring and using the Licence Server**

Now see **Configuring the Licence Server** on page 21.
Installing Sibelius on the client computers
Once you have installed and configured the Licence Server, you need to install the Sibelius client application on each client machine you want to use with the Licence Server: see Installing Sibelius on page 17.

Uninstalling the Licence Server
If you need to uninstall the Licence Server (e.g. to upgrade it, or to install it on another computer), do so as follows:

• Choose Start > Control Panel, then double-click Programs and Features.
• In the list of installed programs, select Sibelius 7 Licence Server, and click Uninstall.
• Follow the on-screen prompts to uninstall the Sibelius Licence Server.

Once the Licence Server has been uninstalled, the registration data is also removed, and if you subsequently reinstall the Licence Server on the same computer, you will have to re-register and reconfigure it.
If you are upgrading your Licence Server from any earlier version of Sibelius, see Upgrading on Mac OS X on page 15.

Installing the Licence Server

The Licence Server and the associated Control Panel application should be installed to the Applications folder on your Mac's system volume, and scripts are installed in the /Library/StartupItems folder so that the Licence Server starts automatically when your computer starts up.

The provided installer will install all the files to the correct locations, and you are strongly recommended to accept the default locations. If you want to install the Licence Server to another location on your computer, you will have to manually edit the scripts in /Library/StartupItems and /Applications/Sibelius 7 Licence Server after installation. This is not something that inexperienced network administrators should attempt!

To perform the standard, recommended installation:

- Insert your Sibelius 7 Program Disc DVD-ROM. A window should appear showing a number of icons: first, open the Network Licence Users Only folder, then double-click Install Sibelius Licence Server to begin.
- The following window will appear:

  ![Image of installer window]

  Click Continue to proceed.
Installation on Mac OS X

You are asked to select the destination volume for the software to be installed. Choose your Mac's start-up volume, then click **Continue**.

- Next, you are told that the installer will perform a standard installation:
- You are now prompted to provide an administrator username and password: do so, and click **OK**.
- Next you will see a progress bar as the files are installed to your Mac's hard disk:

- After a few moments, you will be told that the installation has completed successfully.

- Click **Close** to exit the installation.

**Configuring and using the Licence Server**

Now see **Configuring the Licence Server** on page 21.
Installing Sibelius on the client computers
Once you have installed and configured the Licence Server, you need to install the Sibelius client application on each client machine you want to use with the Licence Server: refer to Installing Sibelius on page 17.

Uninstalling the Licence Server
To uninstall the Licence Server:

• Run Terminal, which you can find in `/Applications/Utilities`.
• In a Finder window, go to the Sibelius 7 Licence Server folder inside your Applications folder.
• Drag the `uninstall.sh` file onto the Terminal window.
• You will see `/Applications/Sibelius\ 7\ Licence\ Server/uninstall.sh` appear in the Terminal window: hit Return.
• You will be prompted to provide your administrator password: do so and hit Return.
• You will see a few messages output to the Terminal window as the Licence Server is shut down and deleted.

Once the Licence Server has been uninstalled, the registration data is also removed, and if you subsequently reinstall the Licence Server on the same computer, you will have to re-register and reconfigure it.
Upgrading on Windows

To upgrade your network site licence from Sibelius 1.4, Sibelius 2, Sibelius 3 or Sibelius 4, Sibelius 5 or Sibelius 6 to Sibelius 7, you will need to upgrade both the Licence Server and all the client machines.

Upgrading previous versions of the Licence Server

• Quit the Licence Server on the computer on which it is installed, referring to the appropriate booklet.

• If you have the Licence Server installed as a Windows service, uninstall it:
  - For Sibelius 1, 2 and 3: go to the Licence Server console and type `uninstall`.
  - For Sibelius 4: open a command window (by clicking `Start`, typing `cmd` and hitting `Return`), navigate to the folder that contains the Licence Server and type:
    ```
    LicenceServerV4 -v -uninstall
    ```
  - For Sibelius 5.0: open a command window (by clicking `Start`, typing `cmd` and hitting `Return`), navigate to the folder that contains the Licence Server and type:
    ```
    LicenceServerV5 -v -uninstall
    ```
  - For Sibelius 5.1 or later: uninstall Sibelius Licence Server via Programs and Features. This will stop and uninstall the service, and remove all the necessary files.
  - For Sibelius 6: uninstall Sibelius 6 Licence Server via Programs and Features. This will stop and uninstall the service, and remove all the necessary files.

It is very important to uninstall the service in the correct way to avoid leaving a service that can’t be removed.

• Delete the folder containing the old Licence Server to avoid confusion with the later version.

Upgrading the client machines

To upgrade each of the client machines, use the Sibelius 7 DVD-ROM and follow the instructions in the supplied printed Quick Start Guide.

When you first run Sibelius 7, the splash screen will say UNREGISTERED COPY as the program is loading (because at that point it has not yet been registered by the Licence Server over the network), and will then change to say Registered to Network User once the program is given permission to run by the Licence Server.

Running multiple Licence Servers

The Sibelius 7 Licence Server can coexist with licence servers for previous versions of Sibelius between Sibelius 6 and Sibelius 3, and may be run simultaneously and installed concurrently on the same server.

If you need to do this, it will be necessary to change the port number used by at least one of the licence servers. It may be simplest to change the port number used by the new Sibelius 7 Licence Server, in which case:

• Temporarily stop your existing Licence Server, consulting the documentation that was supplied with that version of the Licence Server.
Sibelius Licence Server User Guide

- Install the Sibelius 7 Licence Server, following the instructions in Installation on Windows on page 7.
- Change the port number used by the Sibelius 7 Licence Server, following the instructions in Changing the port used by the Licence Server on page 40.
- Restart your existing Licence Server, consulting the documentation that was supplied with that version of the Licence Server.

When signing on a client copy for the first time to a licence server with a different port number, the syntax for the server IP address will be, for example, 192.168.1.183:8989 (where 8989 is whatever new port you have chosen).

If you do not have the most up-to-date Sibelius 3 or 4 Licence Server, visit:
http://www.sibelius.com/helpcenter/upgrades.html#network
to download the latest version.
Upgrading on Mac OS X

To upgrade your network site licence from Sibelius 1.4, Sibelius 2, Sibelius 3 or Sibelius 4, Sibelius 5 or Sibelius 6 to Sibelius 7, you will need to upgrade both the Licence Server and all the client machines.

Upgrading the Licence Server

- **For Sibelius 1, 2, 3, 4 and 5.0:**
  - Run Terminal, change to the root user (`sudo bash -login`), navigate to the folder that contains the Licence Server (`cd /usr/local/bin`) and run the script called `stop_licence_server` (`./stop_licence_server`).
  - If you have set the old version of the Licence Server to run on start-up, e.g. by specifying that it should run in `/etc/rc.local`, you should also disable this. You can disable the line in question simply by adding a `#` character at the start of the line. If you followed the instructions supplied with the previous version, the line probably looks like this:
    `/usr/local/bin/start_licence_server`
  - You should also delete the old Licence Server executable and the three associated scripts. Again, these will normally be found in `/usr/local/bin`.

- **For Sibelius 5.1:**
  - Run Terminal, which you can find in `/Applications/Utilities`.
  - Type `sudo /Applications/Sibelius\ Licence\ Server/uninstall.sh` and hit Return.
  - You will be prompted to provide your administrator password: do so and hit Return.
  - You will see a few messages output to the Terminal window as the Licence Server is shut down and deleted.

- **For Sibelius 6:**
  - Run Terminal, which you can find in `/Applications/Utilities`.
  - Type `sudo /Applications/Sibelius\ 6\ Licence\ Server/uninstall.sh` and hit Return.
  - You will be prompted to provide your administrator password: do so and hit Return.
  - You will see a few messages output to the Terminal window as the Licence Server is shut down and deleted.

- Install, register, configure and run the Sibelius 7 Licence Server according to the instructions in Installation on Mac OS X on page 10.

Upgrading the client machines

To upgrade each of the client machines, use the Sibelius 7 DVD-ROM and follow the instructions in the separate printed Quick Start Guide.

When you first run Sibelius 7, the splash screen will say **UNREGISTERED COPY** as the program is loading (because at that point it has not yet been registered by the Licence Server over the network), and will then change to say **Registered to Network User** once the program is given permission to run by the Licence Server.
Running multiple Licence Servers

The Sibelius 7 Licence Server can coexist with licence servers for previous versions of Sibelius between Sibelius 6 and Sibelius 3, and may be run simultaneously and installed concurrently on the same server.

If you need to do this, it will be necessary to change the port number used by at least one of the licence servers. It may be simplest to change the port number used by the new Sibelius 7 Licence Server, in which case:

- Temporarily stop your existing Licence Server, consulting the documentation that was supplied with that version of the Licence Server.
- Install the Sibelius 7 Licence Server, following the instructions in Installation on Mac OS X on page 10.
- Change the port number used by the Sibelius 7 Licence Server, following the instructions in Changing the port used by the Licence Server on page 40.
- Restart your existing Licence Server, consulting the documentation that was supplied with that version of the Licence Server.

When signing on a client copy for the first time to a licence server with a different port number, the syntax for the server IP address will be, for example, 192.168.1.183:8989 (where 8989 is whatever new port you have chosen).

If you do not have the most up-to-date Sibelius 3 or 4 Licence Server, visit:

http://www.sibelius.com/helpcenter/upgrades.html#network

to download the latest version.
Installing Sibelius

Example scores
Before you install Sibelius, you should liaise with your music staff or network administrators about the best place to install Sibelius's example scores.

• On Windows, Sibelius installs the example scores into a folder called Example Scores inside the Sibelius 7 program folder, and creates a shortcut to this folder inside the My Documents folder belonging to the current user. If you want to make these files available to all users, you should manually copy the Example Scores folder to an appropriate location on the network.

• On Mac, Sibelius installs the example scores into a folder called Sibelius Example Scores inside /Users/Shared/Documents, which will be accessible to all users on that client machine.

Installing Sibelius on your client machines
It is essential that Sibelius or Sibelius Student be installed on the local hard disk of each client machine. It cannot be installed on a network drive or a virtual disk.

You can install on all the client computers using the same serial number; as long as all your computers are connected on the same network via TCP/IP and can thus see the machine running the Licence Server, they can share the same licence.

You can install Sibelius or Sibelius Student on as many computers as you like, but the Licence Server will only allow as many copies as are licenced to be run simultaneously; you could, say, install Sibelius on 30 computers, but if you only have a licence for 10 copies, only 10 copies will be able to run simultaneously.

Note that, regardless of how many copies you have bought, you will only receive one installation DVD-ROM and serial number, valid for the appropriate number of licences purchased.

Install Sibelius on each of your client machines following the instructions in your Handbook, using the same serial number (starting SCEM, SCEW, SWEW, or SCEG) that you used to install and register the Licence Server (you don't need to register the client copies).

Alternatively, you can install Sibelius 7 on each client machine using a special command that will automatically set the serial number and Licence Server address at installation time, rather than when running the client for the first time. To do this:

• Insert the Sibelius 7 DVD-ROM in the client machine. When the main installation menu appears, click Exit.

• Open a command window: on Windows XP, choose Start > Run, then type cmd and hit Return; on Windows Vista, click Start, type cmd and hit Return.

• Type the following command:

D:\Sibelius\InstallSibelius.exe /SERIAL=serialno /LSINFO=ip:port /SILENT

where you should replace:

• D with the drive letter corresponding to your DVD-ROM drive

• serialno with your serial number, without spaces, e.g. SCEM700123456123456
Running for the first time

When you first run Sibelius 7, the splash screen will say **UNREGISTERED COPY** as the program is loading (because at that point it has not yet been registered by the Licence Server over the network), and will then change to say **Registered to Network User** once the program is given permission to run by the Licence Server.

**Note about subnet masks**

A subnet mask is used on a TCP/IP network to determine which IP addresses belong to the individual network, or subnet. For example, a typical network uses IP addresses in the range 192.168.1.n (where n is an integer from 0-255); in this case, the subnet mask would be 255.255.255.0, signifying that only the last digit of the IP address of each client machine on the network may be variable. The final digit of the subnet mask address varies according to the precise range of the subnet: a value of 0 allows the full range of 0-255 to be used in the IP addresses of the client machines.

In some cases, particularly where a network uses dynamically-assigned IP addressing (via DHCP), the subnet mask on the machine running the Sibelius Licence Server may not be correctly configured to allow access by all client machines on the network.

The symptoms of this problem are as follows:

- Sibelius cannot find the Licence Server on the network, but;
- it is possible to ping the server machine from the client machine and vice versa.

If you experience the above problem, review the subnet mask settings on both machines. If your network uses a router to control access from one subnet to another, the router will take precedence over the subnet mask setting.
Configuring and using the Licence Server
Configuring the Licence Server

Terminology
Before we get into the details of how to configure the Licence Server, some important terms are defined here:

- **Server**: this is the Licence Server program itself, as opposed to a service (see below).
- **Service**: a process on your computer that runs in the background performing one or more specific tasks. Many services are started automatically when your computer runs, or when a specific user logs in. The Licence Server is intended to be run as a service, meaning that it will be started automatically when the computer is started.

Licence Server states
When the Sibelius Licence Server is running, it can be in one of four different states, which are normally passed through in order, as follows:

- **Installed**. Simply running the installer achieves this state.
- **Running the service**. The installer also automatically starts the service.
- **Registered**. You have to provide the Licence Server with its registration information (the Sibelius serial number and Registration Number) in order to move into the final state.
- **Running the server**. As soon as the Licence Server is registered, it becomes fully operational, and can authorize client copies of Sibelius.

You can stop and restart the Licence Server at any time using the Licence Server Control Panel; when you restart it, it will return to the same state as when you stopped it.

Once the Sibelius Licence Server reaches the fourth and final state (running the server), it is ready to use.

Running the Licence Server Control Panel
In order to see the status of the Licence Server and make changes to its configuration, you use the Licence Server Control Panel. You can run the Control Panel either on the same machine that the Licence Server is installed, or on another workstation. To run the Control Panel:

- On Windows, choose **Start** → **Control Panel**, then double-click **Sibelius 7 Licence Server**. If you don't see the icon in your Control Panel, you can also find it in your Start menu, in **Programs** → **Sibelius Software** → **Sibelius 7 Licence Server** → **Control Panel**.
- On Mac, navigate to the **Sibelius 7 Licence Server** folder inside **Applications**, then double-click the **LicenceServerControlPanel** icon.
The following window will appear:

As you can see, there are six pages in the Control Panel:

- **Server Status** shows the status of the server at a glance, and allows you to perform the essential configuration tasks: locating the server; starting and stopping the service (Windows only); starting and stopping the server; and setting the teacher’s password for Sibelius’s Classroom Control feature.
- **Licences** is where you register your Licence Server, allowing you to specify how many floating licences of Sibelius or Sibelius Student you can run simultaneously, and how many (if any) copies can be temporarily checked out onto student computers disconnected from the network.
- **Server Options** allows you to set some more advanced properties of the server, including log verbosity (i.e. how detailed the logs should be), how long the client time-out should be, and what port the server should run on. You can also run some very useful diagnostics on the Licence Server from this page.
- **Access Control** determines which computers can connect to the Licence Server, both for authorizing Sibelius clients and for determining which machines can be used to run the Control Panel to configure the server.
- **Clients** shows details of the clients that are currently connected to the server, and allows you to send messages to them, or close the clients down.
- **Log** shows the Licence Server log file, useful for diagnostics.

The options on each of these pages are discussed in detail in the following pages.
Registering the Licence Server

Connecting to the Licence Server
At the top of the Server Status page of the Control Panel, you can see the IP address of the Licence Server that the Control Panel is connected to:

By default, the Control Panel assumes that the Licence Server is running on the same machine, which is represented by the special IP address **127.0.0.1**, on the default port (**7312**).

You can tell whether or not the Control Panel has successfully connected to the Licence Server by reading the status message in the Server Status group at the bottom of the page.

If the Control Panel has successfully connected to the Licence Server, you will see the following status message:

If you see this message, skip down to **Adding a licence to the Licence Server** on page 25.

Unable to connect?
If the Control Panel is unable to connect to the Licence Server, you will see the following status message:

If you see **Licence Server is not responding**:

- Click the Find button at the top of the page. The Control Panel will then search your local network for running Licence Servers. If multiple running servers are found, you will be prompted to choose which Licence Server to connect to. If, on the other hand, you are told that **No Licence Servers were found on your subnet**, or if one or more servers appears, but not the one you expect to see, read on.
- Check your firewall rules. Make sure that port 7312 is open for both TCP and UDP traffic, then click Find again.
• If **Find** reports no licence servers, click **Set** and the following dialog will appear:

If the Licence Server is running on the same machine from which you are running the Control Panel, make sure that **Server is running on this machine (localhost)** is switched on.

If the Licence Server is running on another machine, type the IP address of the machine.

• If you still can’t connect, check that the Licence Server process is running:
  - On Windows, run the **Services** management console (choose **Start**, then type `services.msc` and hit **Return**). In the list of services, look for **Sibelius Licence Server V7**: check that **Status** is set to **Started**:

If **Status** is empty, then the service is not running, and you should try starting it manually – see **Appendix A: Starting or stopping the Licence Server** on page 47.
On Mac, run Activity Monitor (from /Applications/Utilities), and make sure that the **Show** drop-down at the top of the window is set to **All Processes**. Type **licence** into the **Filter** edit box, and you should see the **LicenceServer** process listed:

Don't worry if the **LicenceServer** process is colored red and says *(Not Responding)*. This is a quirk of how the Licence Server process appears in Activity Monitor; provided the CPU usage for the process is at a low level (e.g. below 10%), chances are everything is working fine. If the **LicenceServer** process does not appear in the list, you should try starting it manually – see **Appendix A: Starting or stopping the Licence Server** on page 47.

- If all else fails, refer to the further troubleshooting steps in **Troubleshooting** on page 42.

**Adding a licence to the Licence Server**

Before any of your client computers can connect to the Licence Server, you need to add a licence and register it. Switch to the **Licences** page, which looks like this:
The Licences page allows you to add licences for multiple products so that you can, for example, run separate licences for both Sibelius and Sibelius Student on the same network (as provided in the Sibelius Student Network Pack). Each product can have one or more licences, identified by an individual serial number, and appears as a separate row in the table on the Licences page.

The columns in this table are as follows:

- **Product** shows the name of the licenced product. Normally this will say either Sibelius or Sibelius Student, as appropriate.
- **Serial number** shows the serial number of the licenced product. This will typically begin with SCEW for Sibelius, or ZCEW for Sibelius Student.
- **Registered** shows whether or not the licence is currently registered: if this says No, then client copies will not be able to obtain a licence from the Licence Server.
- **Total licences** is the total number of seats for which your licence is registered: if this says e.g. 25, then a total of 25 client copies can connect to the Licence Server concurrently.
- **Licences available** is the number of licences that are not currently in use by clients connected to the Licence Server.
- **Max. check outs** is the total number of licences from the Total licences number that are allowed to be checked out by students so that they can disconnect their computers from the network and continue to use the software for a time, e.g. at home.
- **Checked out now** is the total number of licences that are currently checked out to students. Licences that are checked out to students are not available on your network while they are checked out: so if you have a 25-seat licence, and five seats are checked out to students, only 20 client computers will be able to connect to your Licence Server until those copies are checked back in.

For more information on checking out licences, see Checking out licences on page 33.

For now, simply click Add. A dialog appears into which you should type your serial number, which will normally begin SCMM for Sibelius, or ZCEW for Sibelius Student:

Click OK, and the serial number is added to the list of licences:
Notice that Registered says No, which means that client copies cannot yet connect to the Licence Server, so click Register. The following dialog appears:

- Click Generate Computer Number to generate your Computer Number. Now you should contact Sibelius registration with your serial number and Computer Number. (If you have multiple licences to add, it makes sense to add each of them and send all pairs of serial numbers and Computer Numbers together, so you will receive all the Registration Numbers together.)
- When you receive your Registration Number from Sibelius registration, type it into the Registration Number edit box.
- Type the number of seats in your license into the Number of copies edit box.
- Once you have typed both the number of copies and the Registration Number correctly, the OK button will become enabled.
- Click OK to complete the registration: after a few moments you will be told that your registration was successful.

In the table on the Licences page, the Registered column will now read Yes for that serial number. If you switch to the Status page, you will now see the following status messages near the bottom of the page:

Congratulations! Your Licence Server is now registered and running. Notice that you are told the total number of copies in your license (in the above example, 25 clients), and how many clients are connected at the moment (in the above example, none).

If you have another licence to add and register, e.g. for the copies of Sibelius Student in your Sibelius Student Network Pack, follow the steps above again.

The next step is to test client-server communication with the Licence Server using the built-in testing feature.
Testing the Licence Server

Once you have registered the Licence Server, you can test client connections to the server using the Licence Server Control Panel. Choose the **Server Options** page:

To test client connections, simply choose one of your registered products from the **Serial number** combo box, set the **Number of clients to simulate**, then click **Run Test Now**. The Licence Server Control Panel will spawn the specified number of windows (so be careful not to set too high a number!), each of which pretends to be a running client copy of Sibelius or Sibelius Student. Each window has a colored background:

A green background means that the test client is running successfully. You can see a log of the communication the client has received from the server in the pane at the bottom of the test client window.
Testing the Licence Server

If a test client fails to connect for whatever reason, it shows a red background:

Again, you can see the reason why the test client failed to connect in the pane at the bottom of the window. In the above example, the Licence Server already had the maximum number of allowed clients connected, so it refused authorisation (hence the message **not enough licences**).

To close all the test client windows, click **Close All Test Clients**.

**If no test clients can connect**

If no test clients are able to connect to the Licence Server, consider the following:

- Is the Licence Server running, and if so, is it correctly registered? Check the read-out under **Server Status** on the **Status** page of the control panel.
- Is your firewall blocking communication between the Licence Server and the test clients? Make sure that the correct port (**7312** by default) is open for both the TCP and UDP protocols.
- Is the Licence Server prevented from accepting client connections from the IP address of the computer you are using to test the connection? See **Access Control** on page 30.

If all else fails, consult **Troubleshooting** on page 42.
Access Control

On the Access Control page of the Licence Server Control Panel, you can set up rules about which computers on your network can connect to the Licence Server in order to authorize client copies of Sibelius or change settings for the Licence Server itself.

Clients and Managers

By now you will be familiar with the term client, meaning a computer on which Sibelius is installed, and which will be connecting to the Licence Server for authorization. Clients are specified by IP addresses, or ranges of IP addresses.

A manager is a computer from which it is possible to change settings for the Licence Server. As with clients, managers are specified by IP addresses.

Typically, you would need somewhat permissive access control for clients (because you may have Sibelius installed on every computer in the school, for example) and less permissive access control for managers (because only, say, the network administrator and the teacher's workstation should be able to change Licence Server settings).

Allow or Block

Simply put, a machine at a given IP address can connect to the Licence Server if it is set to allow, and cannot connect to the Licence Server if it is set to block.

Setting up access controls

By default, only the local machine's IP address (127.0.0.1) is given access to the Licence Server as a manager, but any machine (***.*) can connect to the server as a client. This means that you typically don't need to configure anything in order for client machines to connect to the Licence Server.
Access Control

However, you may want to specify particular ranges of IP addresses for clients and managers, in which case read on.

Local area networks usually use one of three specially designated ranges of IP addresses (10.0.0 – 10.255.255.255, 172.16.0.0 – 172.31.255.255 or 192.168.0.0 – 192.168.255.255). If you are not sure what range of IP addresses is used by your network, contact your network administrator before you proceed.

Normally you will want to grant client access to your whole subnet. For example, if the IP addresses of all your clients are in the range 172.16.0.0 – 172.16.1.255, you would type 172.16.*.* into the boxes provided, as follows:

![Access Control Interface](image)

then click the Allow button next to Client, then click Apply to send your changes to the Licence Server. An asterisk (*) means that the Licence Server should accept any value in the range 0–255.

You may need to block client access to a particular IP address or a range of machines, in which case enter the IP address as above, and click Block, then Apply.

To grant manager access, enter the IP address as above, then click the Allow button next to Manager, then Apply. You are recommended to limit manager access to only those machines that absolutely require it.

To remove a specific access control restriction, select the appropriate row in the table at the top of the page, then click Delete.

If at any point you want to reset the access control settings to their defaults, click Restore Defaults. You will be asked to confirm that you want to proceed: click Yes.
Sibelius Licence Server User Guide

Setting up Classroom Control

Sibelius’s Classroom Control feature allows you to perform simple classroom management tasks directly from within Sibelius, including sending files to student workstations, getting files from student workstations, “freezing” the client copies of Sibelius so that you can attract the attention of the students in the classroom, and more.

Setting the teacher password
To ensure that only the teacher has access to the File > Classroom Control dialog in Sibelius. To change the password, go to the Status page of the Licence Server Control Panel, and click Change teacher’s password. The following dialog appears:

Type the default password (sibelius) into the Current password field, then type your new password into the New password and Confirm password fields, and click OK. The Licence Server Control Panel will warn you if the passwords don't match, or if the new password is the same as the current password. Make sure you keep your password secure, and try to make it difficult for students to guess.

For more information, § 5.3 Classroom Control in Sibelius Reference.

Classroom Control for multiple products on the same network
If you have the Sibelius Student Network Pack, you will have at least one copy of Sibelius, and at least 20 copies of Sibelius Student, which are all connected to the same network. As such, when the teacher uses File > Classroom Control in Sibelius, he or she will see all copies of both Sibelius and Sibelius Student that are currently running on the network.

Client copies of Sibelius and Sibelius Student behave identically with regard to Classroom Control, though the File > Classroom Control dialog for the teacher is only available in full Sibelius, and not in Sibelius Student.
Checking out licences

If students at your institution have their own laptop computers that they bring to school, you may find it useful to allow students to take copies of Sibelius or Sibelius Student home with them for a time, e.g. for the duration of a semester, or over a weekend or the summer vacation.

Such a temporary licence is a **check out licence**, because the student “checks it out” of the Licence Server when he or she wants to take his or her computer away from the school network, and then “checks it back in” when he or she next connects to the school network once more. If the student does not check the licence back in, it eventually expires, after which the student is no longer able to run the software on his or her computer until it is reconnected to the school network.

When a licence is checked out from the Licence Server, the pool of available licences remaining for use on the school network decreases by one seat for the duration of the check out period, so it is important to specify a limit to how many of the total seats in your licence can be checked out by students at once.

You may even find it useful to purchase additional seats, or indeed a separate licence, specifically for the purpose of checking out licenses for students: you can run multiple licences on the same licence server, so you could earmark one licence for use on the school network, and another licence for check our licences for your students.

**Setting up check out licences**

The first step for setting up check out licences is to decide how many of the total number of seats available in your licence should be allowed to be checked out at any one time. If you have a 25 seat licence, you may want to limit the number of check out licences to, say, 10 copies, so that there are always at least 15 seats available for use on your school computers.

By default, no licences are made available for checking out, so you have to choose how many to allow. Go to the **Licences** page of the Licence Server Control Panel, select the licence for which you want to allow check out licences, and click **Check Out Settings**. The following dialog appears:

![Check Out Settings dialog](image)

To enable check out licences, switch on the **Allow x of y licences to be checked out** checkbox. By default, the number of licenses to be checked out defaults to half of the total number of licences available, but you can change this to as many or as few of the available licences as you like.
Check out licences are by their nature temporary, so next you must choose how long to allow the licences to be used for. You can choose between allowing licences to be checked out for a certain number of days, which is useful for allowing students to routinely check out licences for short periods, e.g. weekends, or until a particular date, allowing students to check out licences for an extended period, e.g. up until the end of the semester or the academic year.

To allow a licence to be checked out for a certain number of days, choose the in n days radio button, and specify the number of days. To specify a fixed expiry date, choose the on this date radio button and type the date using the format dd/mm/yyyy, e.g. 31/07/2010 (31 July 2010).

When you are happy with your settings, click OK. The Max. check outs column in the table on the Licences page of the Licence Server Control Panel reflects the number of check out licences that you have specified.

**Monitoring check out licences**

You can see the number of licences that are currently checked out at a glance in the Checked out now column of the Licences page of the Licence Server Control Panel.

For more detailed information, look at the Clients page of the Licence Server Control Panel, where you can see details of which users currently have licences checked out: the Licence Server records the user account name and the machine name (if available), and shows when the check out licence will automatically expire.

**Revoking check out licences**

There may be circumstances in which you need to revoke a check out licence to return that seat to the pool of floating licences before the licence is checked back in by the student, or before its automatic expiry time. For example, if the student's laptop is lost or stolen, or if the student leaves the institution.

When you revoke a check out licence, it is returned immediately to the pool of floating licences, but that licence will nevertheless remain active on the computer on which it was checked out until it expires, at which point the client copy of Sibelius will no longer run on the client.

To prevent abuse of this system, the number of times you can revoke check out licences is limited to the total number of seats in your licence: if you have a 30 seat licence, you may revoke check out licences 30 times, but once you reach this limit, you will need to contact Sibelius to re-register your Licence Server to reset this limit. At the point at which the check out licence would have expired, the record of the revocation is removed, increasing the number of available revocations by one. To help you keep track of this limit, Sibelius will tell you how many revocations you have available when you revoke a check out licence.

To revoke a check out licence, go to the Clients page of the Licence Server Control Panel, select the client in the list, and click Revoke Licence. You are asked to confirm that you do indeed want to revoke the licence: click Yes. The client disappears from the list, and the Checked out now column is reduced by one on the Licences page of the Licence Server Control Panel for that licence.
Checking out licences

Before they can check out a licence from the Licence Server, your students should install Sibelius (version 6.1.5 or later) or Sibelius Student (version 6.1.5 or later) on their laptops in the usual way. To make this easy for them, you could copy the installer to a suitable shared location on your school network, and provide a text file alongside the installer that contains the serial number for that copy of Sibelius or Sibelius Student, together with the host name or IP address of the computer on which the Sibelius Licence Server is running.

Once the student has Sibelius or Sibelius Student installed on his or her computer, he or she should connect to the school network and run the program as normal. After entering the serial number and Licence Server address, the software will run connected to the Licence Server, using one of the available floating licences.

To check out a licence, the student chooses Help ▶ Check Out Licence from within Sibelius or Sibelius Student. If the Licence Server is not configured to allow check out licences, the student will receive a message to that effect. If the Licence Server is configured to allow check out licences, however, the student will see the following dialog:

The student can choose when the check out licence will expire, up to the maximum duration specified by the Licence Server. When he or she clicks OK, Sibelius disconnects from the Licence Server, and the student can then disconnect from the school network. For the duration of the check out period, the student can run Sibelius on his or her computer without reconnecting to the school network. In the last few days before the check out licence is due to expire, the student will be warned each time he or she starts Sibelius so that work can be planned effectively.

Once the licence has expired, the student will receive a message when he or she starts Sibelius informing him or her that the program cannot run unless it is reconnected to the Licence Server.

Checking in a licence

If a student wants to check a licence back in before it expires, he or she must reconnect his or her computer to the school network, run Sibelius or Sibelius Student as usual, then choose Help ▶ Check In Licence. Sibelius then tries to contact the Licence Server and return the licence to the pool of floating licences, at which point Sibelius will once again only run on that computer when connected to the school network.

If for any reason Sibelius or Sibelius Student cannot contact the Licence Server, the student will receive a message to that effect, and should try again later.
Working with clients

The **Clients** page of the Licence Server Control Panel shows real-time information about the client copies of Sibelius currently connected to the Licence Server:

- **Address** shows the IP address from which the client is connected. It is possible for multiple clients to appear to connect from the same IP address if your Licence Server is located on the opposite side of a firewall or router from your client machines, or in other situations where your network uses Network Address Translation (NAT).

- **Client ID** is a numeric identifier given to each client machine when it first connects to the Licence Server. This identifier remains associated to that client machine as long as it is connected to the server for that session, and when the client disconnects and reconnects (e.g. because a student quits and restarts Sibelius), it will be assigned a new identifier. Similarly, when the Licence Server is restarted, the client IDs are simply reassigned from 1 again. (Client IDs are used by the Licence Server to ensure that it can tell each client apart, especially when your network employs NAT.)

- **User name** shows the username of the account currently logged in to that particular computer.

- **Machine name** shows the host name of the client computer.

- **Time connected** shows how long each client has been connected for, in hours, minutes and seconds.

- **Last polled** shows when the Licence Server last polled the client and received a reply. Typically, clients will be polled every few seconds, and only when you suffer a network outage of some kind (or when the client computer crashes) will the client not be able to respond to the Licence Server's poll message.

- **Licence expires** shows the date on which the client’s checked out licence expires in the form `dd/mm/yyyy`, or shows **N/A** if the licence is a standard floating licence.
In addition to seeing real-time information about the clients currently connected, you can perform some simple operations on the client machines, namely sending a message to one or more clients, closing one or more clients, or revoking a checked out licence.

**Sending messages to clients**
If you need to send a message to one or more clients, e.g. to inform them that the lesson ends in a few minutes, or that the computer lab will be closing shortly, you can select the client (by clicking) or clients (by Shift-clicking or using Ctrl+click or ⌘-click) from the list at the top of the dialog, then click **Send Message**. A simple dialog appears:

![Send Message dialog](image)

Type your message and click **OK**. Your message will appear within a few moments on the screens of each of the clients to whom you chose to send it.

**Closing clients**
To close one or more client, select the client (by clicking) or clients (by Shift-clicking or using Ctrl+click or ⌘-click) from the list at the top of the dialog, then click **Close Selected Clients**. Within a few moments, each of the client machines will prompt the student to save their work, and then shut down.

**Revoking licences**
If a client has a checked out licence, and you urgently need to restore that licence to the network pool so that it can be allocated to another client, select the client and click **Revoke Licence**. You can only revoke licences a limited number of times, so use this capability sparingly. For more information, see **Checking out licences** on page 33.
Reading logs

The Logs page of the Licence Server Control Panel shows the log messages generated by the Licence Server:

- **Time** shows the timestamp at which a given event occurred.
- **Client Address** either shows the IP address of the client machine, or if it is an informational message generated by the Licence Server itself, this will read (Status).
- **Message** shows the text of the message itself. Some of the common messages you will see:
  - **Adding client id: n (x of y)**: when a client first connects to the Licence Server, it is assigned client ID n, and you are informed that this is copy number x of the number of concurrent copies allowed, y.
  - **Client add request version**: this means that a client has asked the Licence Server for authorization.
  - **Client alive**: this means that a client has been successfully authorized.
  - **Poll response from client id n**: this is the response of the client to the Licence Server’s poll request.
  - **Poll count -1 for id n**: this means that client ID n has stopped responding to the Licence Server’s poll requests.
  - **Removed client from list**: this means that a client has closed.

The buttons at the bottom of the page allow you to perform various operations on the log:

- **Save As**: if you encounter problems with the Licence Server, it is very useful to send your log file to Sibelius technical support. Simply click **Save As** to save a text file suitable for attaching to an email.
Reading logs

• **Clear** will empty the log. Note that this not only clears the display in the Licence Server Control Panel: it deletes the existing log altogether. (The log is also deleted each time you start the Licence Server.)

• **Refresh** forces the display of the log file to be updated. The display is automatically updated every few seconds, but if you want to force an update, you can do so.

• **Mark** inserts a marker line in the log file, which can be useful when trying to diagnose what the Licence Server is doing while it's running.

• **Status** inserts a status report message into the log, including important bits of configuration information (including the Licence Server's serial number, IP address and port, number of registered copies, client and manager access control lists, and so on) that can help Sibelius technical support to diagnose any problems you may encounter.

• **Comment** shows a simple dialog into which you can type a comment to be inserted in the log file. You can use this to annotate a sequence of events in the log: again, this can be very useful in helping Sibelius technical support to diagnose problems.

Log verbosity

You can control how detailed the Licence Server logs are by adjusting the slider on the **Server Options** page of the Licence Server Control Panel:

![Verbosity slider](image)

While you are configuring and testing your Licence Server, you may find it helpful to drag the slider to the right to increase the verbosity. Once your Licence Server is running smoothly, you can safely drag the slider back to the left in order to make the logs more concise.
Maintaining the Licence Server

There are a handful of other maintenance tasks that can be performed from the Licence Server Control Panel, described below.

Changing the port used by the Licence Server

The Licence Server’s default port is 7312. There is normally no need to change this, and we recommend that you leave this setting at its default.

If, however, you need to change the port, click Change Port on the Server Options page of the Licence Server Control Panel. The following dialog appears:

```
To change the port used by the Licence Server, specify the new port number below. Note that changing the port will disconnect any clients who are currently using Sibelius. In order for clients to reconnect to the Licence Server, you will need to reconfigure each client machine to use the new port.

New port: 5012

Cancel OK
```

As the message in the dialog makes clear, changing the port after you have already set up your Licence Server can be very inconvenient, because you need to reconfigure each client machine to use the new port afterwards.

Changing the number of copies in an existing site licence

If you decide to increase the number of copies in your Sibelius network site licence by purchasing additional seats for one of your existing serial numbers, you will need to un-register your Licence Server and obtain a new Registration Number from Sibelius registration.

To un-register your Licence Server, select the appropriate serial number in the table on the Licences page, then click Unregister. You will be asked if you are sure you want to un-register the Licence Server: if you click Yes, that serial number will become unregistered, and it will no longer be able to authorize any client copies of Sibelius or Sibelius Student.

To re-register your Licence Server with a larger number of copies, follow the procedure described in Registering the Licence Server on page 23.

Unexpected exits

In the unlikely event that a copy of Sibelius running on a client machine exits unexpectedly (e.g. if it crashes), or if the computer on which Sibelius is running crashes or requires a reboot, when the student runs Sibelius again, the Licence Server will attempt to identify that the same client is reconnecting, and re-authorize it immediately. If, however, the Licence Server is unable to recognize the client, the student may see the error message **Sibelius cannot run because the server already has a copy registered on this address**. In this situation, the student can wait for the designated time-out period, and he or she will then be able to successfully restart Sibelius.
By default, the time-out period is three minutes, but you can change this on the **Server Options** page of the Licence Server Control Panel:

![Slider Image](image)

Simply drag the slider to the right to increase the time-out period, or to the left to reduce it.
Troubleshooting

Error codes
For a complete list of the error codes that can be returned by the Licence Server, see Appendix C: Licence Server error codes on page 50.

Error 0005 Access Denied
If the Licence Server service in Windows fails to start automatically, you may get an Error 0005 Access Denied when you try to start it manually. This usually means that the folder in which the Licence Server is installed has restricted access.

Licence Server is apparently installed correctly but the clients cannot “see” the Licence Server
- Open a command window (Windows) or Terminal window (Mac) and use ping to contact the server from the client and vice versa to establish basic connectivity. If ping is successful in both directions, network traffic is able to be routed between the two machines. If ping fails, it’s possible that another device on the network (e.g. a programmable switch) is blocking the traffic between the Licence Server and the client. Check the logs to see if you are getting an “extra slave alive” message.
- Review your access settings using the Access Control page of the Licence Server Control Panel – see Access Control on page 30.
- This can also be caused by your firewall. Try this trick: if you are running the Control Panel on the same machine as the Licence Server, add the server’s IP address to the list of allowed managers, then connect to the server by IP address (or use the Find button). If you are unable to connect or test the server in this way, it suggests that the firewall on your local machine is not allowing connections through on the Licence Server’s port. If you are able to test the server but other clients still can’t connect, then check the settings of any other firewalls or routers on your network.

Error message ‘Could not bind the IP socket to the correct port’
If you see the error message Could not bind the IP socket to the correct port when running the Licence Server, you may be running another application on this port already. You may even be running the Licence Server already: perhaps you are running an earlier version of the Sibelius Licence Server at the same time as the Sibelius 7 Licence Server, or perhaps the Licence Server has crashed and the crashed process needs to be killed before it can be restarted.

If you legitimately have another application using the same port, you can solve this problem changing the Licence Server’s port (see Changing the port used by the Licence Server on page 40).

Client copies of Sibelius on Mac lose contact with the Licence Server
Make sure that your server is not allowed to go to “sleep” as this will stop the Licence Server from responding. You should also ensure that your server does not install software updates automatically, as this will also stop the Licence Server from responding.
Troubleshooting

**Licence Server fails to test successfully**
Did you forget to include the localhost, 127.0.0.1 in your clients allowed access control list?

**Using the log to troubleshoot**
The log can be very informative when investigating a client that fails to be authorized.

For example, you will see `Bad serial number` in the log if a client attempts to connect using a different serial number than the one in use by the Licence Server.

You will see `Bad version number` if a copy of an older or newer version of Sibelius attempts to connect to the Licence Server, e.g. you will see `Bad version number 6` if a copy of Sibelius 6 attempts to connect to the Sibelius 7 Licence Server.

You will see `Blocked client, no copies left` if a new client attempts to connect to the Licence Server, but the Licence Server has already authorized the number of copies in your licence.
Appendix A: Starting or stopping the Licence Server

Normally you should use the Licence Server Control Panel to start and stop the Licence Server. But should you need to start or stop the Licence Server without using the Control Panel, you can do so as follows:

Starting the Licence Server on Windows

• First, open a command prompt window: click **Start**, type **cmd** and hit **Return**.
• This opens a command shell window:

  ![Command Prompt Window](image)

  • Navigate to the folder where you installed the Licence Server using **cd**:
    
    `cd \Program Files\Avid\Sibelius 7 Licence Server`

    Make sure you type the line above exactly, with spaces in all the right places. You will be returned to the command prompt in the above directory. (On 64-bit Windows, substitute **Program Files (x86)** for **Program Files**.)

• Now, to install the service, type:
  
  `LicenceServerV7 -install`

• You will see the following response from the Licence Server:

  ![Licence Server Response](image)

  • You will again be returned to a command prompt.
Stopping the Licence Server on Windows

- First, open a command prompt window: click **Start**, type `cmd` and hit **Return**.
- This opens a command shell window. Navigate to the folder where you installed the Licence Server using `cd`:
  
  ```
  cd \Program Files\Avid\Sibelius 7 Licence Server
  ```

  Make sure you type the line above exactly, with spaces in all the right places. You will be 
  returned to the command prompt in the above directory.
- Now, to install the service, type:
  
  ```
  LicenceServerV7 -uninstall
  ```

  You will again be returned to a command prompt.

Starting the Licence Server on Mac OS X

- Open a Terminal window and log in as root by typing:
  
  ```
  sudo bash -login
  ```

- Type the root password when prompted, and hit **Return**.
- Now type the following command:
  
  ```
  /sbin/SystemStarter -v start "Sibelius 7 Licence Server Service"
  ```

Stopping the Licence Server on Mac OS X

- Open a Terminal window and log in as root by typing:
  
  ```
  sudo bash -login
  ```

- Type the root password when prompted, and hit **Return**.
- Now type the following command:
  
  ```
  /sbin/SystemStarter -v stop "Sibelius 7 Licence Server Service"
  ```
Appendix B: Manually locating Licence Server logs

Normally you should view the Licence Server's logs using the Licence Server Control Panel, but should you need to do this manually, do so as follows.

Logging on Windows
The Licence Server creates a log file called LicenceServerV7.log, normally located in:

C:\Users\LocalService\AppData\Roaming\Avid\Logs

The exact location depends on your computer’s settings, so it may be necessary to search for the folder. The logs are updated with every event.

Logging on Mac OS X
The Licence Server creates a log file in /var/log called LicenceServer.log (unless you have changed its name and location in the start_licence_server script). To see the last few entries in the log, open a Terminal window and navigate to the /var/log folder or the folder you have specified for the log file. Assuming you are using the default filename, type:

```bash
tail -f LicenceServer.log
```

To quit the `tail` command, type `Control-C`. To view the whole log, use the `less` command:

```bash
less LicenceServer.log
```

Quit the `less` command by typing `q`.
# Appendix C: Licence Server error codes

<table>
<thead>
<tr>
<th>Error code</th>
<th>Internal error message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>301</td>
<td>ERR_LS_CANT_CONNECT_TO_SERVER</td>
<td>The service is not yet running</td>
</tr>
<tr>
<td>302</td>
<td>ERR_LS_AUTH_NO_MORE_COPIES</td>
<td>No more licences left on server</td>
</tr>
<tr>
<td>303</td>
<td>ERR_LS_AUTH_ALREADY_RUNNING_THISS_IP</td>
<td>A version is already running at this address</td>
</tr>
<tr>
<td>304</td>
<td>ERR_LS_AUTH_DENIED</td>
<td>Can't authorize this client</td>
</tr>
<tr>
<td>305</td>
<td>ERR_LS_SHUTDOWN</td>
<td>Server has requested that we shut down</td>
</tr>
<tr>
<td>306</td>
<td>ERR_LS_INCORRECT_SIB_VERSION</td>
<td>Licence Server is for a different version of Sibelius.</td>
</tr>
<tr>
<td>307</td>
<td>ERR_LS_OLD_LS_VERSION</td>
<td>Using the wrong version of the Licence Server</td>
</tr>
<tr>
<td>308</td>
<td>ERR_LS_CLIENT_COMM_ERROR</td>
<td>Can't communicate with client</td>
</tr>
<tr>
<td>309</td>
<td>ERR_LS_INVALID_SERIAL</td>
<td>Invalid serial number</td>
</tr>
<tr>
<td>310</td>
<td>ERR_LS_NO_ACCESS</td>
<td>No access control has been set up</td>
</tr>
<tr>
<td>311</td>
<td>ERR_LS_SOCKET_FAIL</td>
<td>Can't create or bind network sockets</td>
</tr>
<tr>
<td>312</td>
<td>ERR_LS_SERVICE_CANT_FIND_MODULE</td>
<td>Can't find LicenceServerV7 executable to install as a service (Windows only)</td>
</tr>
<tr>
<td>313</td>
<td>ERR_LS_SERVICE_CANT_OPEN_SERVICE_MAN</td>
<td>Can't open the service manager (Windows only)</td>
</tr>
<tr>
<td>314</td>
<td>ERR_LS_SERVICE_CANT_CREATE_SERVICE</td>
<td>Can't create the service (Windows only)</td>
</tr>
<tr>
<td>315</td>
<td>ERR_LS_SERVICE_CANT_START</td>
<td>Error starting the service (Windows only)</td>
</tr>
<tr>
<td>316</td>
<td>ERR_LS_SERVICE_CANT_OPEN</td>
<td>Error opening the service (Windows only)</td>
</tr>
<tr>
<td>317</td>
<td>ERR_LS_GENERAL_ERROR</td>
<td>General error from the Licence Server</td>
</tr>
</tbody>
</table>
Appendix D:
Useful command line commands

Useful Mac OS X Terminal commands
- **chmod** – used to change the attributes of a file
- **ls -al** – lists all the files in a directory with their attributes
- **ps -a** – lists running processes, which will include the Licence Server
- **ps -ax** – lists all running processes, including hidden ones.
- **mkdir -m 775 name** makes a directory called *name* with full read/write access for the owner and their group (typically the admin group), but prevents write access for other users.
- **tail -f logfilename** will display the last 10 lines of the log file *logfilename* continually; useful for monitoring client messages.
- **less logfilename** will display the whole log file *logfilename* from beginning to end; quit by typing *q*.
- **cd** changes the current directory
- **pico** starts the Pico text editor (if installed)
- **logout** will log out from the current user, e.g. root. (You can also type **Control-D**.)
- **./filename** will run an executable or script called *filename* in the current directory, provided you are using bash or a bash-compatible shell (as suggested earlier). Once unique characters have been typed, the **Tab** key will auto-complete the rest of the file name for you.
- To quit a running command, type **Control-C**.

Useful Windows/DOS commands
- **cd** – change directory (the old name for folder).
- **cd ..** – moves to the next higher directory. If you repeat this enough times, you will get back to the root of the hard disk.
- **cd \** – moves you to the root directory.
- **cd \directoryname** – takes you to the directory called *directoryname*. If you copied the Licence Server program to a folder named *LSV6* (for example) then **cd \LSV6** will get you there.
- **dir** – lists the contents of a directory. Use this to check that you are in the right directory.
- **exit** – closes a command prompt window.
- To quit a running command, type **Ctrl+C**.